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¢ The Virtual Observatory

Astronomy being transformed by Information
Technology

o Generate large data sets
— High speed digital signal processing
— Large format CCDs
— HPC-based simulations

> How to deal with the data?

— Access, analyze, archive
— New telescopes only going to exacerbate challenge




¢ The Virtual Observatory

The VO is a data discovery, access, and
integration facility

« Image, spectral, time series data
« Catalogs, databases

. . )CVO
e Iransient event notices
« Software and services @-—-

o Distributed computing
authentication, authorization, \ po
process management # NowA R\Q e 0 @
o Application inter-communication

International coordination and collaboration



The Virtual Observatory
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¢ VO impact and penetration

Astronomers use VO every day without realizing it

o Afew examples
— Major archives and data centers are VO compliant
— Hubble Legacy Archive is built with “VO Inside”
— Dark Energy Survey pipeline and archive
— WIYN One-Degree Imager pipeline and archive
- Pan-STARRS
— LSST development

« ~1M VO-compliant service requests every 2 weeks
from several sites



o US VO efforts

NVO mmp PO

NATIONAL VIRTUAL OBSERVATORY

o National Virtual Observatory (NVO) development effort, 2001-08
- $14M, 17 organizations
— NSF Information Technology Research program

« Virtual Astronomical Observatory (VAO) operational facility, 2010-2015
Managed by VAO,LLC, co-owned by AUl and AURA
— VAO Board of Directors (J. Gallagher, chair)
— Science Council, G. Fabbiano (CfA, acting)
— Users Committee, C. Miller (U. Mich.)

/ -
w US Virtual Astronomical Observatory

Home  Science Tools & Services  Aboutthe VAO VO News  Support & Community  Contact & Connect Search

http://www.usvao.org/




¢ Research Collaborations

« Call for Proposals issued in Accepted

January Sz
o Serving data and models of the
VAO to provide in-kind resources to J

further a well-defined research Magellanic Clouds from Spitzer

project and/or expose valuable and He{‘schel legacy programs
data to the community (Pl: Meixner)

o Think about next year! o Serving light curves from the

American Association of Variable
\V/.To Star Observers (PIl: Templeton)

« VO image interfaces to the NASA

Extragalactic Database (PI:
Science Collaborations wl;hJ;r:: ;Irl;l't::; 2Astronomlcal Observatory S C h O m b e rt)

Proposals due: 1 March 2012

The US Virtual Astronomical Observatory (VAO) seeks proposals from the astro- { ] VO-CO m p I i a nt d ata b a S e S fo r th e

nomical research community for science collaborations that utilize virtual obser-

vatory capabilities or develop novel virtual observatory tools to produce new re- O u

search results. Proposals may be in any area of astronomy, but projects that EVOI u tl O n a ry M a p Of th e U n Ive rse
benefit from the integration of data in multiple wavelength regions, that involve

analysis of time-domain data sets, and/or utilize large databases or data sets are ] ]

the most germane to the VAO. The VAO Science Council has suggested, for a n d Va rl a b I e a n d S I OW Tra n S I e nt
example, that multi-wavelength studies of M31 would be a good candidate for

such a_collaboration. but proposals in any area of astronomy are welcome and

b st Survey Science Projects (PI:

The VAO cannot directly fund these collaborations, but will provide in-kind sup-

port in using and adapting VO technologies in the selected projects. Such sup-

port may include VAO technical staff visiting a research team or covering travel M u rp hy)
costs for members of a research team to visit a VAO organization. Ongoing sup-

port will be in the form of telecons, e-meetings (e.g., using WebEx), a Wiki site, or

other on-line collaborative tools.
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VAQO Science Tools

http://www.usvao.orgqg/

s us Virtu_al_ A tro _o_mical Qbservatory

Home  Science Tools & Services Aboutthe VAO VO News Support & Community Contact & Connect

Science Tools & Services

Data Discovery Tool

Retrieve astronomical data about a given position or object in the sky.

Iris: SED Analysis Tool

Find, plot, and fit spectral energy distributions (SEDs) with this desktop application.
Cross-Comparision Tool

Perform fast positional cross-matches between an input table of up to 1 million sources and
common astronomical source catalogs.

Time Series Search Tool

Discover time-series data from three major archives & analyze them with the NASA Exoplanet
Archive periodogram application.

View a welcome and introduction to the VAO Science Tools from director Robert Hanisch:

Welcome to the VAO Share ¥ More info

‘Robert Hanisch

Director - Virtual Astronomical Observatorv

0:08

More VO Tools & Applications

Below is just a selective sample of the VO tools and services that have been developed by various Virtual
Observatory projects around the world. For a more complete listing, see this evolving list at the IVOA
Applications Working Group page. Prototypes produced by the predecessor to the VAO are still available
at http://www.us-vo.org

* Monitor real-time alerts of transient events: Skyalert
Manipulate tabular data graphically: TOPCAT

Find and overlay images at different wavelengths: Aladin
Make mosaics from 2MASS, DPOSS, or SDSS: Montage

.
.
.
« Plot results from VO queries: VOPlot

£

£
N .

VAO Tools & Services

Data Discovery Tool - Retrieve
astronomical data about a given
position or object in the sky.

Iris: SED Analysis Tool - Find, plot
and fit spectral energy distributions
(SEDs) with this desktop application.
Time Series Search Tool — Discover
time-series data from three major
archives & analyze them with the NASA
Exoplanet Archive periodogram
application

Cross-Comparison Tool — Perform
fast positional cross-matches between
an input table of up to 1 million sources
and common astronomical source
catalogs.

More News from the VO

Aladin update from CDS

VAQ Working with LSST, SDSC

The VAO at the SPIE Telescopes &
Instrumentation Conferences

VAO Software Release: Data Discovery
Tool (version 1.3)

VO Inside: NASA HEASARC Xamin
Catalog & Archive Interface

How To Use Cloud Computing To Do
Astronomy

Welcome to the (new) VAO Website!
Astronomy Computing Today: New
Astronomy Projects Take Up The
Virtual Observatory

Member of the
International Virtual Observatory Alliance




¢ Time Series Tool

VAO Time Series Tool * Discover time series data
—— - Harvard Time Series Center

Discover time series data sets at the , the at IPAC/Caltech,
and the at CACR/Caltech, and analyze them with the NASA Exoplanet Archive's ( I S C )

periodogram application.

This service Is to a pathfinder for developing a utility that interconnects repositories of time series data. Please give us — N ASA E XO p I a n et A rC h i Ve at

your feedback - itis important in driving future VO capabilities.

This service Is recommended for use with the most recent versions of Firefox, Chrome or Safarl. Internet Explorer I PA< :/‘ : a I te C h

9, old versions of Firefox (prior to version 8) and Opera are not supported.

VAO Time Series Search - Catalina Real-Time Transient
Use the fields below to enter a search location and radius. Survey at CACR/CaIteCh

* Analyze with the NASA
Exoplanet Archive's
O (= e - periodogram application

NStED TrEdS(Tra ns-atlantic Exoplanet Survey) observations of the Keple

CACR Catalina Real-Time Transit Survey

Example Locations:

»Pathfinder for developing
. utility that interconnects
T time series data
repositories
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Time Series Tool I

Kepler

10

Kepler planetary candidates N TrES (Trans-atlantic Exoplanet Survey) observations of the Kepler field
star_id 9941662 star_id TrES_Lyrl_00173
koi 1301 region TrES_Lyrl
field The Kepler Field ra 286.971250
ra 286.971159 dec 46.868330
dec 46.868401 bmag 10.704000
pm_ra 0.000000 vmag 10.476000
pm_dec 0.000000 J rmag 11.504000
pm_total 0.000000 rerr 0.039100
[sal lat 16.806619 starthjd 2453541.787548
[gal_lon 77505951 endhjd 2453616.734163
meg null lefil R
[gmag 9.697000 npts 11398
rmag 10.045000 ledisp 0.140000
imag 10.548000 lcchisq 13356.299805
zmag 10.020000 nSsig 0
|gredmag null tSsig 0.000000
[d51mag 9.669000 Lpublic Y
jmag 9.465000 ‘F'el‘erence ids|8
hmag 9.455000 -

9425000 ! download
9.958000
4 plot
filter Kepler Magnitude -
IR periodogram
transit_duration 3.202900 /) ?é
B =

After searching on an object,
examine its entries in a time

series data set ...

TrES
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Time Series Tool |l

NASA Exoplanet Archive Light Curve Viewer

NASA Exoplanet Archive Light Curve Viewer
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Download Time Series
Convert Format

Plot the time series as a “quick look” ...

TrES
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Tool Series IV

About Usage

Periodogram
Linear® Log®

NASA Exoplanet Archive Periodogram Service

Performance

Star ID: 9941662

Troubleshooting

Algorithms

T
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Period (Days)

Most Significant Periods

P-value

0.881834 2755.170455 Phased curve
2 1.762381 2664.109661 0 Phased curve
3 0.587816 2100.440015 0 Phased curve
4 0.440943 2075.150904 0 Phased curve
5 0.352784 1613.287483 0 Phased curve

A

v

The P-values above are computed for 359080 periods sampled, and an exponential power distribution is

assumed. A note of caution when interpreting the results from the periodogram: The

( Y

call

lated

ee P

review our algorithms page.

) of ranked periods may not be reliable. Several factors m:
invalidate the assump{lons applied in esl:mahng the statistical significance. To learn more, pleas

O BLS

type

Parameters

| gr€ate Periodogram

® Lomb-Scargle

(O Plavchan

Current Vaiues

Lomb-Scargle

Input file
37057

kplr009941662-
2...2_slc_lc.tbl
Number of points:

View Time Series

__ TIME

e column (| pMin: 231.3826, Max

258.4763

TIME

Data column

~ PDCSAP_FLUX

5 75.
Max: 172

Constraints Range

PDCSAP_FLUX

Time :
Constraint AT
column Max
Data :
Constraint T
column Max
Column
; | SAP_QUALITY
Constraint - 'Q— 0.000000
range Min “0.000000
0.000000

Max "5 000000

Adjusichla Periodogram Param-~‘ss

The estimated time for

Period Sampling

mpute Optimal Period [

Min 0.040000

. 0.040000
Period range
Max  27.093714 27.093714
\Perggfh;ffp (Fixeddf 1% FixedDf
Me 0.00006950 0.00006950

T —

Analyze!

12



13

¢ Data Discovery Tool

Cornell University

Question:
Astrophysics > Earth and Planetary Astrophysics 1 - Ca n I CO m bi n e my d ata
SOPHIE velocimetry of Kepler transit candidates VII. An additional W|th eX|St| ng data to

companion in the KOI-13 system

A. Santerne, C. Moutou, S. C. C. Barros, C. Damiani, R. F. Diaz, J.-M. Al ,A.S.B , F. Bouchy, M. d t d bJ t
De;&:gzébra;u ou arros amiani faz menara onomo ouchy. un erS an an O eC

. - Search or Article-id
arXiv.org > astro-ph > arXiv:1207.1715

(Submitted on 6 Jul 2012) b tt t?
We report the discovery of a new stellar companion in the KOI-13 system. KOI-13 is composed by two fast-rotating e e r L)
A-type stars of similar magnitude. One of these two stars hosts a transiting planet discovered by Kepler. We obtained
new radial velocity measurements using the SOPHIE spectrograph at the Observatoire de Haute-Provence that revealed E KO I - 1 3 S Ste m
an additional companion in this system. This companion has a mass between 0.4 and 1 Msun and orbits one of the two - "

main stars with a period of 65.831 \pm 0.029 days and an eccentricity of 0.52 \pm 0.02. The radial velocities of the two
stars were derived using a model of two fast-rotating line profiles. From the residuals, we found a hint of the stellar

L]
variations seen in the Kepler light curve with an amplitude of about 1.41 km/s and a period close to the rotational 2 D O I n ee d to a Cq u I re
period. This signal appears to be about three order of magnitude larger than expected for stellar activity. From the -
analysis of the residuals, we also put a 3-sigma upper-limit on the mass of the transiting planet KOI-13.01 of 14.8 Mjup .
and 9.4 Mjup, depending on which star hosts the transit. We found that this new companion has no significant impact on a d d Itl O n a | d ata O r d O
the photometric determination of the mass of KOI-13.01 but is expected to affect precise infrared photometry. Finally,
using dynamical simulations, we infer that the new companion is orbiting around KOI-13B while the transiting planet
candidate is expected to orbit KOI-13A. Thus, the transiting planet candidate KOI-13.01 is orbiting the main component

of a hierarchical triple system. th ey eXi St a | re a d y?

Comments: Accepted in A&A. 4 pages including 4 figures and the RV table

: . i - . i -ph.. I
zli:tlzjeacst:s, ::;tlcla;g;lla;les!:;y[:ss‘trr:_r:::;:]s (astro-ph.EP); Solar and Stellar Astrophysics (astro-ph.SR) a . k . a . O bse rvatl O n a | O r
.
proposal planning



Data Discovery Tool
searches VO-aware
collections for data

-Catalog, images,
spectra
*\Waveband

» Do your data need
to be in a VO-aware
service?

Data Discovery Tool

Search All Virtual Observatory Collections:
User Guide | Discovery Tool v1.3 (4816)...

o

Start Page [ KOI-13 r=1m

34 Total Rows

L4 new rows received | Refresh Table
filters

Clear Filters  Edit Facets... Help...

| Categories

Catalog
Custom Service
Images
Spectra

4 | Waveband

EUV
Gamma-ray
Infrared
Millimeter
Optical
Radio
Ultraviolet
uv

Visible
X-ray

4 | Publisher

CDS

ESO

German Astrophysical Virtual
Observatory

NASA Astrophysics Data
System

NASA/GSFC HEASARC

NASA/HEASARC

NASA/IPAC Infrared Science
Archive

National Optical Astrono

Observatoire de Paris

Space Telescope Science

Space Telescope Science
Institute

StarDB team, Department of
Astronomy, Yonsei University

Sternberg Astronomical
Institute Virtual Observatory
Project

Vlathad Chaban Masal

] KOI-13 r=10s

Export Table A: BD+46 2629 (RA: 19:07:53.107, Dec: +46:52:05.95), radius
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=
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[

Short Name

KTC

SkyView

DSS ESO

2MASS QL

2MASS ASKY AT
IRTS

ROSAT SIA

ADS

HEAVENS @ 1SDC
ISSA

HEAVENS @ 1SDC
Simbad

Enhanced KIC_CT
DSS1IR

USNO-B1

Tycho-2

DFBS
twomass-psc
nomad

gsc2 3.2

ACRS
USNO-SA2.0
2MASS-PSC
NOMAD
USNO-A2.0

SAO

USNO-A2

GsC23

Kepler Planetary Can...
KIC_CT

KIC

StarDB's NSVS CS
ExoPLanet [2]

exoplanet-cat

14

Radius: ' 10

KOI-13 X Arcses |V

Examples: M101, 14 03 12.6 +54 20 56.7, more...

Search

Title

Kepler Data Search

SkyView Virtual Observatory

Digitized Sky Survey

2MASS All-Sky Quicklook Image Service

2MASS All-Sky Atlas Image Service

The Infrared Telescope in Space Data Atlas

SIA Service for ROSAT Archive

Astrophysics Data System

Mining the HEAVENS with the Virtual Observatory
The IRAS Sky Survey Atlas

Mining the HEAVENS with the Virtual Observatory
The SIMBAD astronomical database

Enhanced Kepler Target Search

First Digitized Sky Survey: Red Plates

USNO-B1 Catalogue

Tycho-2 Catalog of the 2.5 Million Brightest Stars 1
Digitized First Byurakan Survey

The 2MASS All-Sky Catalog

The Naval Observatory Merged Astrometric Datas
The Guide Star Catalog II (GSC-II), version 2.3.2
Astrographic Catalog of Reference Stars
USNO-SA2.0

2MASS All-Sky Point Source Catalog

NOMAD Catalogue

USNO-A2.0

Smithsonian Astrophysical Observatory Star Catal
USNO-A2 Catalogue

Guide Star Catalog 2.3

Planetary Candidates observed by Kepler

Kepler Target Search

Kepler Input Catalog

StarDB: variability analysis of the Northern Sky Vz
Extrasolar Planets Encyclopaedia

extrasolar planet interactive catalog including bit

4



o SED tool: Iris

15

SEDs needed
to understand
emission
physics
e.g., star vs.
disk

X axis

Y axis

( SpectralAxis

a
4] [ FluxAxis

(‘Gridoff %) [ Fixed [3] ( Plottype ) @E

4]  208.63048 | 5.898031

Flux density (Jy)

0.1

( Expand

Print ) ( Redraw )

RS

¢ ) | iy B unis )
( Metadata ) Flux density ﬂ (_ Units )

Wavelength (um)

Ll
1000.0

GM Aur
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Cross-Matching

I @h : o = Compared kic_test.txt (13161029 sources)
[}l Upload a table 0 Max Match 1
: Distance: arcsec
I User Tables v | On-line Catalogs
‘ Delete  File # Rows # Columns Size Catalog # Rows
() kic_test.txt 13161029 4 737 MB IRAS_PSC 245889

SDSS_DR7 453846233
TWOMASS_PSC 470992970
USNO_B1 1045175762
WISE_prelim 257310278

History

Delete = User Table Catalog Max Max Min Avg Input #Matches #Bad #Unmatched
Dist Match Match Match Rows Records Records
(arcsec) Dist Dist Dist Matched
O kic_test.txt WISE_prelim 1 1.0000 0.0003 0.4198 1636747 1636747 0 11524282

v

# Columns
81
95
127
56
277

Time

269.06

16




Cross-Matching and Cross-
|dentification

Cornell University
Library

Search or Article-id

arXiv.org > astro-ph > arXiv:1207.0521 D i Sti N g u iS h CrOSS-matChing

Astrophysics > Earth and Planetary Astrophysics

Confusion limited surveys: using WISE to quantify the rarity of and CrOSS-Identlﬁcatlon

warm dust around Kepler stars

G. M. Kennedy, M. C. Wyatt .CrOSS-matChlng 9 tWO

(Submitted on 2 Jul 2012)

We describe a search for infra-red excess emission from dusty circumstellar material around 180,000 stars

L]
observed by the Kepler and WISE missions. This study is motivated by i) the potential to find bright warm O bJ e CtS a re at th e S a l I I e

disks around planet host stars, ii) a need to characterise the distribution of rare warm disks, and iii) the
possible identification of candidates for discovering transiting dust concentrations. We find about 8,000 stars

that have excess emission, mostly at 12um. The positions of these stars correlate with the 100um : t : th k 1 th 1
background level so most of the flux measurements associated with these excesses are spurious. We identify pOS I I O n O n e S y WI I n
271 stars with plausible excesses by making a SMJy/sr cut in the IRAS 100um emission. The number counts

of these excesses, at both 12 and 22um, have the same distribution as extra-Galactic number counts. Thus, - .

although some excesses may be circumstellar, most can be explained as chance alignments with background u n Ce rta I n tl eS )

galaxies. The one exception is a 22um excess associated with a relatively nearby A-type star that we were

able to confirm because the disk occurrence rate is independent of stellar distance. Despite our low detection

rate, these results place valuable upper limits on the distribution of large mid-infrared excesses; e.g. fewer Cf_ b rown dwa rf Sea rCh eS

than 1:1000 stars have 12um excesses (F_ obs/F_star) larger than a factor of five. In contrast to previous
studies, we find no evidence for disks around 1790 stars with candidate planets (we attribute one significant

12um excess to a background galaxy), and no evidence that the disk distribution around planet hosts is ° A Ad 5 =
different to the bulk population. Higher resolution imaging of stars with excesses is the best way to rule out rOSS- I e n I I Ca I O n WO
galaxy confusion and identify more reliable disk candidates among Kepler stars. A similar survey to ours that
focusses on nearby stars would be well suited to finding the distribution of rare warm disks. t d " ﬁ t

Compared

L]

Upload a table 0 r—
. m L same object

(13161029 sources)

kic_test.txt

User Tables v On-line Catalogs v
Delete  File # Rows  # Columns. Size Catalog # Rows. # Columns. ] [ ]
O Keteston 13161029 4 7B IRASPSC 24588 o -
So55_0R7 3046233 o5
TwomASs_PSc 470992970 27
uswo_B1 10175762 s _— .
WISE_prelim 257310278 277
History >
Deete UserTable  Catalog vax vax vin ™ Input smatches | #8ad sUnmatcned Tme
oist vatch Match vateh Rows Records | Records
(arcsec) Dist Dist Dist Matched f
O Ketestot  WISE prelim 1 1.0000 0.0003 048 163677 1636747 0 usae 26906 |




o VAO-IRAF Integration

’\
|
20
Query, Service Calls, etc

i SAMP

Desktop Environment

S L aye ‘__ : fSAMP
s IR 'T,-‘-": ‘ Data Access

VO Services

18

« 2000 registered
IRAF users

*~ 5000 total
users

> 700 IRAF tasks
now VO-aware

> 1000
downloads of

IRAF v. 2.16
as of 2012 April 1



o seleste

ﬂ @) 0 seleste

ﬂ E AbAd
Open | Save | Clear | - | Services Form | ADQL Help

Two Micron All Sky Survey (2MASS)
Contents: [l. Intro | 2. Service 3.Columns 4. Table Joins 5. Criteria 6. Position Search 7. Submit Query 8. Jobs |

[# twomass_psc Welcome to seleste!
[ twomass_scn
twomass_xsc
twomass_pscXBestDR7PhotoObjAll

You are in the query Guide mode. In this mode you will be guided through the steps of building a query and viewing results with the above
tabs.

You can control the query mode through the View menu or by clicking the icons on the toolbar:

QD

ADQL | Guide

Form

Select the Form mode if you want a single screen view of the query. Select the ADQL mode to type in your query directly as ADQL. You can
change the query mode that seleste starts with by using the Preferences dialog in the Edit menu.

While working on a query, you may use Save to save your current query, Open to load your query from a previous save, or Clear to clear
out the current query. These commands are under the File menu or in the toolbar:

HH

Open | Save | Clear

Use Help to learn more about features in seleste.

To continue to the next step, click the 2. Service tab above.

T T M
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Intuitive yet flexible and
powerful access to
catalogs, or any
tabular data

Discover and browse
catalogs and databases

Full access to data and
metadata

Quick look results

Customizable for fine-
tuned results

» SQL queries, with click-
and-drag GUI

» Scriptable via command
line interface

* Query results saved or
passed to other VO tools
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VOStat

VOStat, rev 2 is a Web-service providing a suite of statistical

analyses for VO datasets.
— Developed at Penn State
— http://vostat.org/

Java-based GUI to the R public domain statistical software

environment
- > 60,000 functions in > 3500 packages

Input files obtained via SAMP, URL, or user (ASCII, FITS, VOTable)
R code provided to assist user in further analysis on local computer.

VOStat provides ~ 60 statistical functions

2D & 3D plots, smoothers (kernel, ASH), hypothesis tests (K-S, A-D),
regressions (linear, robust, local), PCA, normal mixtures, hierarchical
clustering, spatial (k-NN, Moran’ s |, Ripley’ s K, 2-pt correlation),
directional data, non-detections (Kaplan-Meier, Lynden-Bell-Woodroofe, 2-
sample tests), time series (ACF, ARMA, Fourier)
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Coming Attractions

« Renewed emphasis on Time Series Tool
o Python interfaces to VO libraries and services

o Inter-operability
- E.g., DDT = Iris
— In alpha/pre-beta stage currently
o VO-aware versions of other software packages

e.g., CIAO (Chandra Interactive Analysis of Observations),
CASA (Common Astronomical Software Applications

o Data publishing initiative
- How do | share my data with the community?

— viz. NSF Data Management and NASA ROSES policies
— Currently in pilot stage

21



